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ClickBook is so easy to use.  Just choose File / Print from any program and choose the
"ClickBook Printer" when printing.

1.1 What Does ClickBook Do?

 

ClickBook prints files, documents, graphics, spreadsheets, or web pages from any Windows application:

As Double or Single sided.
As Books of any size.
As brochures or leaflets.
As greeting cards.
As CD Jewel Cases.
As Day Planners.
As business cards.
As Avery Labels.
As Banners of any size (Windows 7, Vista, XP, 2000, only)
As Posters of any size (Windows 7, Vista, XP, 2000, only)
As PDF files

Top Uses for ClickBook:
Print booklets of many different styles and sizes.

Print double-sided without a duplexing printer.
Print Day Planner refills.
Print organization charts or schedules on large posters.
Fit a large spreadsheet on one page with several pages on each sheet of paper.
Combine documents, web pages, and other files into a single print job.
Print an address book to fit in your day planner, purse, wallet, etc.
Create a list of songs and artists and print a booklet that will fit in a CD Jewel Case.
Design Greeting Cards or print electronic greeting cards received.
Print goals, and objectives in large formats for posting on the walls
Gather a collection of recipes and print them as a wallet booklet.
Sales & Marketing Managers use ClickBook to print media, product information, press kits, news, etc.
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Posters for Schedules, Plans, Birthday, Calendars, Pictures, Charity Events, Bulletin Boards, Advertisements (Windows XP,
2000, Vista, 7 only)
Educators print handouts, assignments, lessons, ebooks, posters, etc.
Combine your documents into one convenient PDF file.

About printing books
Printing books requires a special arrangement of the pages.  ClickBook takes care of this, giving you instructions each step of
the way so that the back sides are printed correctly relative to the front sides, and so that after you cut and assemble the book,
the pages come out in the right order.

ClickBook has over 170  layouts to choose from, and you can create your own so the variety is endless.  The layouts that come
with ClickBook enable you to print:

Sizes from poster size down to credit card size.
Suited for folding and stapling or for cutting and binding by any method.
Two "binding orientations": for binding in the left margin (and turning pages in the standard way) or in the top margin (and
flipping pages up).
Pages of book oriented either as portrait or as landscape.

1.2 How Does ClickBook Work?

ClickBook takes what you print from your application – exactly what would print if you were not using ClickBook – and shrinks
and rearranges the pages to fit the layout you choose.

ClickBook does not change any formatting done by the application program.  Each page is preserved exactly as the application
sent it, including margins, page numbering, headers/footers, and all paragraph formatting – everything.

ClickBook formats your document in some or all of the following ways, depending on the printout layout you select and any
modifications you may make to it:

Shrinking to fit several pages on one sheet of paper.
Expanding it to "poster" sized and printing it on multiple pages. (Windows XP, 2000, Vista, 7 only)
Arranging the mini-pages so that they come out in numerical order after cutting and assembling.
Printing double sided.
Adding ClickBook margins.
Adding extra space for binding.
Adding Headers, Footers or Watermarks.

1.3 What's New In ClickBook MMX?

Look at all of the great features we have added to ClickBook MMX.

Enhanced 64-Bit Operating System Compatibility- ClickBook  (Windows 7 and Vista only)
Ability to open other document types - ClickBook can now open many 'known' file types. (Requires app support for
printing)
New Printer Setup -  Updated and enhanced printer setup with 'Auto-Detect'.
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New Catergory/Layout Interface - Layouts can now be in multiple categories. You can also restore default layouts back to
factory settings.
Updated Interface - Fresh new look and feel with animated icons .
Improved Duplex Settings - New duplex settings for printers capable of automatic duplexing.
Ability to select printer features - You can now choose paper tray, quality, and color/bw from the Modify Layout window.
Quick Click Printers- The ability to activate or inactivate Quick Click Printers for improved printer folder organization.
Improved Setup - Automatically sets up known printers, and addresses know printer issues. Renamed quickbook printer to
instant book and added e-book 'Quick Click Printer'
Updated Borders - Fixed previous bug and allows borders to line up properly on mini pages, includes diagnostic borders.
Updated PDF Converter - Multi-language (unicode) support now enabled by default .
Printer Troubleshooter - Enhanced printer troubleshooter to help easily resolve printer setup issues.
Digitally Signed Macros - New Digitally signed macros for MS Word, allowing you to print to ClickBook with 'One Click'
Enhanced Mini Page Adjustment - More intuitive 'Adjust Mini-Page feature from Modify Layout.

ClickBook Suggestions and Feature Requests

We here at Blue Squirrel are dedicated to providing you very useful software and delivering high quality support and customer
service.
We would love to hear from you with any feature request or product improvements that you would like to see in future versions of
ClickBook.

If you have any suggestions, product improvements, and/or feature requests please email us at: sales@bluesquirrel.com
We will add your suggestion and/or feature request to our 'Future Feature' list.

1.4 Printing With ClickBook

The ClickBook printing process typically begins in your application program.  You prepare your document as usual, and then you
give the print command.  Set options as you wish in the print dialog box, choose the ClickBook Printer, and click OK.  This
launches ClickBook where you'll select a layout, optionally change other settings, and hit ClickBook's Print button to send the
print job to the printer.

ClickBook gives you instructions at each step of the way, including how to re-insert the paper to print the second sides. 
Following the instructions ensures that the backsides are printed correctly relative to the front sides, and that after you cut and
assemble the booklet, the pages are in the right order.

***NEW*** - You can now open document directly from ClickBook. (Requires app support for printing.)

NOTE: The recommended way to use ClickBook is to print to the 'ClickBook Printer'.

1.5 Printing Your First Booklet

To Print your first ClickBook Booklet follow these steps.

1. Open the document in its application program.
2. Print the document to the ClickBook Printer (Usually File->Print)
3. When ClickBook pops up, select a layout.
4. Click ClickBook's Print button.  (Skip to step 8 now if you're using a duplexing printer.)
5. When the first-side print job is completely finished, remove the printout stack carefully.  Treat the sheets as though they're

glued together – do not rearrange them.
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6. Without lifting it off the stack, read the instruction sheet (with the big arrow).  It tells you whether to put the paper in face up
or face down, and which end of the paper goes in first.  Following the instructions, reinsert the printout stack into the paper
tray.

7. In ClickBook, click the Print Second Side button.
8. When the second-side print job is completed, retrieve the printout and remove the instruction sheet.
9. Assemble the booklet, according to its layout.

1.6 Preparing A Document In Its Application Program

Prepare your document as you usually do, but keep in mind that ClickBook will usually shrink the pages.  (ClickBook will scale
them down unless the layout is full-sized or uses the No scaling setting.)

If you plan to use a layout that shrinks the pages considerably, enlarge your fonts accordingly.  They should be large enough to
be readable at the mini-page size.  Normally, no other special preparation is needed for printing with ClickBook.  But in some
cases you may want to adjust the document in the following ways:

Use a different font that may scale better.  We recommend True Type fonts, which are fully scalable.
When printing a multi-document booklet, modify or add headers/footers that are appropriate for the booklet.  In particular,
you may want to adjust page numbering to be continuous throughout the whole booklet.  See… Headers/footers for a multi-
document booklet.
Turn off right justification of text if the right edge came out uneven on the printout.  
Adjust the margins (or set margins in ClickBook).
Select No scaling and then set everything at exactly the size you want it to print.  This includes setting fonts at desired
sizes, and setting the page size to be equal to the mini-page size in the intended ClickBook layout ClickBook usually
assures that the pages fit the mini-pages, but with scaling off, this is your responsibility.  

1.7 Saving A Booklet As a File

To save a print job as a .cb file just follow these steps:

1.  Press the Save button  on the tool bar.  
   Or,
     Click File on the menu options then click on Save or Save As.

2. The Save As dialog appears.  From the Save in: drop down menu choose the location on your computer where you want to
store the .cbx file.

3. In the File name: field type in the name you wish to call the .cbx file.
4. Press Save. Note: before saving, make sure you've deleted or undeleted documents as desired.  Any documents marked as

deleted when you save will not be included in the ClickBook .cbx file.  Tip: If you want to print similar booklets containing
different subsets of a group of documents, save the whole group as a .cbx file.  Then, whenever you want to print, open the
file and temporarily delete undesired documents.

Note: The .cbx file contains the contents of the documents, not just the file names.  So, if you edit any of the documents after
saving the .cbx file, these changes are not reflected in the .cbx file.
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2.1 Run The Setup Program

The installation setup program for Windows is called ClickBookMMXSetup.exe. You must run the setup program to install
ClickBook to your hard disk.  So that you know what to expect, here's a summary of what the setup program does:

Copies the ClickBook System files to your hard disk.
Creates a ClickBook program group and icons.
Once it's finished installing ClickBook launches the Printer Setup. The Printer Setup dialog box will open and you will set up
the printer(s) you want to use with ClickBook.  ClickBook will automatically configure duplexing printers and printers in the
ClickBook database. If ClickBook does not setup your printer automatically you can setup your printer using the Custom
Printer Setup Wizard.  See "Setting Up an Custom Printer Setup".
At the end of the installation process ClickBook presents you with the option to view the README.RTF, Make  ClickBook
the Default Printer, and install the Microsoft Office Macros.  We recommend looking the README file over because it
contains more information about ClickBook, and the changes that have taken place from previous versions. ClickBook's
online help file provides you with detailed instructions to print the README.RTF as a booklet. Setting  ClickBook as the
default printer is not necessary. Installing the Microsoft Office Macro is optional.
When you first start the ClickBook program the InstantX registration dialog box will appear.  To fully register your copy of
ClickBook please fill out the form, and send it electronically, or print the form and mail it back to Blue Squirrel.  If you don't
register ClickBook the InstantX dialog box will pop up each time you run the program.  Once you have registered, you'll see
your License Key code in the About ClickBook box.

Places a customized Print Using ClickBook command into a menu of your application program.  This feature is available for
several leading application programs.
To Run the Setup Program:

1. If you have ClickBook on a CD insert the CD into an appropriate drive. Or if your copy of ClickBook is a zipped (*.ZIP) or self-
extracting executable (*.EXE) file, copy it into an empty folder.  Double-click or use a zip manager to expand the file.  You
can obtain a copy of the self-extracting executable from our Web site, http://www.bluesquirrel.com/download/
ClickBookMMXSetup.exe..

2. If you have the Blue Squirrel Sampler CD, its AutoStart function will load the CD and present you with an opening screen.
To start the installation process, click on the picture of the ClickBook box.

3. If you have the ClickBook program in another format, click the Windows Start button, choose Settings, and the Control
Panel.  Double-click Add/Remove Programs.  On the Install/Uninstall page, choose Install, and then Next.  Use the Browse
button to navigate to the folder into which you copied or expanded your ClickBook files and click Finish.

4. Follow the prompts on the next screens of the Install Wizard.  

When the Setup program is completed, you will need to setup a ClickBook Printer, setup your printer(s), enter registration
information, and then you're ready to print with ClickBook.

System Requirements

Pentium or faster machine
256+ MB of RAM
14 MB of free disk space
Laser or InkJet printer

2.2 Automatic Printer Setup

The ClickBook installation file should automatically install the ClickBook Printer during the installation process.

If it fails to automatically detect and install the ClickBook Printer follow these steps:

1. When you are finished installing ClickBook, the Add Printer dialog will add a "ClickBook Printer" to your system. If this

http://www.bluesquirrel.com/download/ClickBook12Setup.exe
http://www.bluesquirrel.com/download/ClickBook12Setup.exe
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dialog does not appear go to your Windows Start button, select Programs, Blue Squirrel and ClickBook. If this is the first
time you are opening ClickBook you will need to fill in your registration information, close the Tip of the day dialog and the
Add Printer dialog will appear.  

2. In the Add Printer dialog press OK. 
3. The Add Driver dialog will appear, press OK. Now you have setup a "ClickBook Printer", which will appear in most of your

application programs on your computer.

Now you will need to setup your printer(s) in the ClickBook software.  Go to Printer Setup to do this.

2.3 Printer Setup

Every printer that you use with ClickBook must be set up.  This tells ClickBook how your printer handles paper.  This is
necessary to do double-sided print jobs, and so ClickBook can print in the right order.

If you see the  (icon) next to your printer it means the printer has already been set up with ClickBook.

The printer setup in ClickBook MMX has been enhanced and is much more intuitive.

To setup your printer highlight your printer and click the 'Setup' button. This will launch the Custom Printer Setup and take you
through a step-by-step process where you print some pages, re-insert the paper and then identify the images.  Using the
information that you provide the program sets up your printer for use with ClickBook.

After you have setup your printer, you can highlight your printer and click on 'Properties'. Alternately, you can double click on
your printer to open 'Properties'
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The properties box provides printer information as reported from the print driver. From the properties box you can make printer
corrections and edit the printer setup manually. You can set your printer's duplexing options.

To edit the printer setup manually, click the 'Edit' button next to 'Tray'
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This option lets you answer some questions to provide information to ClickBook about your printer and how it handles paper.  

Remove - Allows you to remove any printers that have been setup for use with ClickBook. When you select the printer and
click remove, the 'Setup' button changes to 'Remove'.
NOTE: Removing the printer from the ClickBook setup only removes it from ClickBook not from your computer.

Properties... - Set the unique properties of each printer.  Does it duplex (print on both sides automatically)? 

2.4 Custom Printer Setup

Here's a summary of what Custom Printer Setup does: First, the program prints two (single-sided) pages and asks you a
question about how they printed.  Next, you're instructed on how to reinsert the printout and begin printing the second pass. 
Afterward, you're again asked to report on what the printout looks like.

To use the Custom Printer Setup Wizard follow these steps:

1. Make sure the printer you wish to setup is ready to print (turned on, online, paper loaded, etc.)
2. Open ClickBook then go to File> Printer Setup.
3. Choose your printer model from the Printer list. Doing so, will enable Setup radio button. 
4. When you're ready to start press the Setup... button. 
5. The Custom Printer Setup Wizard - Overview dialog appears. Follow the instructions presented on the screen.

6. If you want to use a hand fed tray for the second side printing pass please mark the check box next to "I will use the hand
fed tray for the second side."

7. Please repeat steps 1 through 5 to setup a second, third or fourth printer.
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(NOTE: It is very important that you follow the instructions carefully to ensure proper setup of your printer.) 

There are 2 common mistakes made when using the Custom Printer Setup: 
1- Not keeping the pages together preserving the page order 
2- On Step #5, not finding the side printed with the arrow, then comparing the printouts.

2.5 Setting Up A Duplexing Printer For Use With ClickBook

Using a duplexing printer (one that automatically handles double-sided printing) with ClickBook is easy.  ClickBook sends out
only one print job for both the front and back sides, so you skip the step of reinserting the printout stack and then printing the
second print job. 

ClickBook will automatically setup printers that automatically duplex during the installation.

To verify ClickBook has setup your printer for Automatic Duplexing follow these steps:

1. First, make sure that the printer is installed in your Windows system
2. Open ClickBook then go to File> Printer Setup..
3. Choose your printer model from the Printer list.
4. Click the Properties button
5. Make sure 'Automatic' or 'Reverse' is selected in the 'Duplexing' section.
6. Click OK. 

Note: Some printers interpret the duplex request differently.  For certain printers the portrait layouts on portrait paper like 4-Up
Book (folded) rotate differently than portrait layouts on landscape paper like the Side-by-Side (folded) layout.  If only one of these
layouts is upside-down on the back side, choose the "By Layout Fix" option.

2.6 Uninstalling ClickBook

To uninstall ClickBook from your computer please follow these steps:

1. Click the Microsoft Windows Start button on and select Control Panel from the Start Menu.
2. Double click the Add/Remove Programs Icon (Programs Icon in Vista), and the Windows Add/Remove Programs Properties

dialog box appears.
3. Select Blue Squirrel ClickBook in the list of software available, and click the Add/Remove button.
4. The following dialog confirms your request to uninstall.
5. If you are certain you want to uninstall ClickBook click the Yes button.
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3.1 ClickBook's Main Screen

ClickBook's main window is divided into five separate parts: Menu bar , Toolbar , Print Jobs, Status bar, and Print Preview. 

The Menu Bar offers access to commands organized into menus.
The ToolBar offers one-click access to the most commonly used commands.
Print Jobs allows you to print all or a range of pages, determine how many copies to print, which printer will receive the print
job, which applications are going to be printed, and allows you to remove unwanted applications.
Print Preview provides an idea of what the document will look like when it is printed for the chosen layout.
Status Bar displays the total amount of pages that will be sent to the printer, how much paper you will save, and if the Ink
Saver feature is enabled.

3.2 Toolbar

The ClickBook Toolbar offers one click access to frequently used commands.  

 The Open File dialog box appears where you can open an existing ClickBook (.cbx) file, or will open and print some file
types like Doc, RTF, etc.
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 Allows you to save the current project as a ClickBook (.cbx) file.

 Sends the current project to the printer(s).

 Creates a PDF file.

 Opens your default email client and attaches the PDF file you created.

 Change print settings, program settings, and paper/border settings, and header/footer/watermark settings.

 The Poster Wizard lets you create posters of any size or shape. (Windows 7, Vista, XP, 2000 only)

 Inserts a blank page in the Print Jobs.

 Launches the ClickBook Help File. Use this option to learn how to use ClickBook, or to answer specific questions on
ClickBook functions.

 Displays a short explanation for the selected Layout at the bottom of the Print Preview Window.

 Launches your default Internet browser to the Blue Squirrel Home page.

 Displays version and copyright information about ClickBook.

3.3 Print Jobs

The Print Jobs area displays information about the files printed from their corresponding applications.  It also allows you to print
all or a range of pages, determine how many copies to print, and which printer will receive the print job.
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Lists the title and number of pages received for each file.
Select a file and use your mouse to click-and-drag it to rearrange the print order.
Uncheck items to remove files from the project.
Print Status displays how many pages ClickBook received from the application program. 
Printer drop down menu lists the printers you have setup to work with ClickBook, and the selected printer will receive the
print job. 
Print Sends the current files that are listed in the Print Jobs to the printer.

Page Range can be used to print specific pages or a range of pages.   The page numbers are determined by the
red numbers on the Print Preview Window. For example, [1-5,9,15] will print pages 1 through 5, page 9, and page 15.
ClickBook will skip pages 7,8, and 10 through 14.
# of Copies lets you enter the number of copies to print.
Choosing Jobs lets you re-arrange print jobs in your booklet.  Choosing Pages lets you drag and drop pages and re-order
them in any order.
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3.4 Print Preview

The Print Preview screen displays the following:

Shows you how the selected layout for the Print Jobs will look once it is sent to the printer. 
Scroll arrows offer front-side and backside page navigation.
Drop down menus allow you to select various categories, and Layouts.
Sheet Selection allows you to print just the front, back or both pages of a document, as well as, determine which pages to
begin and end printing.
Brief description pertaining to the selected layout.

3.5 Status Bar

The Status bar provides information pertaining to the current Print Jobs.

Paper Saving Meter displays how much paper you will save with the current printout, and how much paper you have saved
overall by using ClickBook.
Scaling status, that allows you to quickly check the scaling of the layout you are using.
Duplex status states whether or not selected printer is set for duplex. If not set to duplex will show printer Paper Path.
Logging Status shows what type of logging you have enabled. E= Errors/W=Warnings/D=Debug
If you are printing a poster, the status bar changes to give you information about the poster you are printing.
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4.1 Sample Documents

ClickBook comes with sample documents for most layouts.  Most of the documents are Microsoft Word documents that can be
used as a starting point when creating booklets, tri-folds, french folds, labels, etc.

The reason for including sample documents is that some of the layouts require specific margins, or number of pages to work
properly with the layout.  The sample documents will be pre-set with those pages, margins and other page settings.

To use a sample document, simply choose the layout you wish to use, then hit the Samples button on the toolbar, or choose
Help->"Sample Documents..." and then hit "Use this layout with its sample document"  

The sample document will be loaded up in Word or other word processor and you can modify the contents to meet your needs.

4.2 Printing A Multi-document Booklet

Summary: To print several documents as a single booklet, just wait to click ClickBook's Print button until after you have sent all
the documents to ClickBook.

When you send a document to ClickBook, the software program opens and begins receiving and processing the document.  If
you send a second document, as long as you have not yet clicked ClickBook's Print button, the second document becomes part
of the same booklet.  You can send a third document, and so on.  The documents can come from different applications, but must
be sent to the same printer.

Note: If you want to print from many applications, you can close each application as soon as it has finished printing (sending the
pages) to ClickBook.  This may help if you find that you don't have enough memory, or that your computer is operating slowly.

Once you have sent all of the desired documents to ClickBook, you can adjust settings – for example, select a different layout. 
Notice that all of your desired documents in the Print Jobs box.  If you want to cancel any of your documents from printing just
click on the check mark in the box next to the documents name.  If you want the documents to print in a different order just left
click and hold on the document you want to move and slide to the desired order of the print job.  

Finally, once you have verified the contents of the booklet and you are ready to print, click Print.

Important: The defining document
The first document you send to ClickBook for a given booklet is the defining document.  ClickBook uses the following settings
from the defining document for all the documents you print together as one booklet.

Page settings (set these in your application or through Windows printer setup):
Page orientation (portrait/landscape)
Page width and height
Layout (set in ClickBook)

Tip: To make sure the settings match, or to find out what the discrepancies are, you can view a list comparing any document
with the defining document.  Just select that documents name (in the Print Job box) and then right-click.

Ensure that you send all documents to the ClickBook Printer.  Some application programs remember the printer last used for
each document.  If your application does this, check the printer for each document before giving the print command.

Printing multiple documents as separate booklets
If you wish to print multiple documents as separate booklets one immediately after another, simply click ClickBook's print button
for one document before you send the next document to ClickBook.  Or , if you send documents to different printers, each
printer's set of documents will be printed as a separate booklet.
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4.3 Poster Wizard

The Poster Wizard is a quick and easy way to make a poster or banner (Windows XP, 2000, 2003, Vista, 7 only).  You choose
the size of your poster or banner, and ClickBook will automatically determine the pages needed to create it.

If you choose Maintain document aspect ration (shape), you can change Width OR Height and the other one will be calculated
for you to keep the poster the same shape as the source document.  If you haven't printed a document to ClickBook yet, it will
keep the same shape as your default paper setting.  Using this option will make it so it does not matter whether you choose 
Stretch to fit, Size to fit (1:1) or Crop/Banner.

Stretch to fit will stretch your source document to fit the poster size.  Photos may not look right if stretched too much.
Stretched letters usually look fine unless stretched too much.

Size to fit (1:1) - will make your document fit and not be stretched.  ClickBook will center the document if you have made the
poster size too wide or too tall.  This is a good option if you have photographs.  

Crop /Banner (1:1) - will make your document fit in one direction only, and crop off the rest if the poster/banner is not the same
shape as the source document. Design your document at the top of the page for a wide banner. Design your document on the
left side of the page for a tall banner.

Save As... allows you to save your custom poster size as a new layout.

A banner is a just a really wide, or really tall poster.  If you want to do a banner, you should choose Crop/Banner and only the
top part of your document will be printed.  In your application (like Microsoft Word), you would put your words like
"Congratulations to Johnny on making straight A's" at the top of the Word document.  The bottom part of the Word document
will be "Cropped" off and not printed on the banner.
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See information on the assembly of your poster.

More options for your custom poster are available under Layouts->Modify Layout...

4.4 Modify Layout

The Modify Layout dialog box allows the user to make permanent changes to any layout format.  It also allows the user to save
their changes as a new layout by selecting Save As or to save their changes over an existing layout by clicking done.

To access the Modify Layout dialog go to Layouts on the menu bar, and select Modify Layouts.

Layout: Displays the current layout.
Style:

Booklet Type - Select a booklet style such as Cut book, Folded book, French fold, Planner pages, Poster, Tiled, Tri-fold
and Zine.
Anti-Shingle -  In large folded booklets with more than 10 sheets of paper the edges start to creep out in the center until
the edge looks like a V.  We call this shingling.  ClickBook can move the page towards the center so you can cut off
excess paper without cutting into printed text.
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Mini-pgs. on Sheet - Select how many pages to put on a single sheet of paper.
Sheet Orientation -  Select if you want the sheet to print in Portrait or Landscape Orientation.
Repeat - The effect of Repeat depends on the current Layout.  Repeat can be used to print more copies when there aren't
enough mini-pages to fill the sheet.   Repeat can also be used, alternatively, to avoid the step of assembling multiple
booklets.  

Printer (* Settings are layout specific.)
Paper Size - Select the size of paper you want to use. NOTE: Default paper size is specified by the Operating System.
Paper Tray - Select the printer paper tray you wish to use. 
Print Quality - Select the print quality you wish to print with.
Print Color - Select between Color and Monochrome. 

Binding
Binding Edge - Choose how you want the binding edge

Printing
Print Sides - Select to print on one side or both sides of paper.

Sub Booklets 
Sub-Booklets - Rather than folding a whole booklet together, you may wish to print and fold sub-booklets separately, and
then bind them together.  Mark the check box to activate sub-booklet printing.  Then set Pages-per to the number of
pages you want each sub-booklet to contain.

Scaling
Absolute Dimensions - ClickBook sets the Mini-page dimensions to fill a sheet of paper. You can set the dimensions by
turning on Absolute Dimensions. 
Width - Specify the width to match a custom page size.
Height - Specify the height to match a custom page size.
Scaling - Choose the type of scaling to use, either One to One, No Scaling, or Stretch to fit. 

Margins
Paper Margins - Allows you to change the margins for a sheet of paper.
Mini-Page Margins - Allows you to change the mini-page margins for the current Layout.
Adjust Mini Pages - Allows you to make corrections to the mini page(s) position. Can be used for Front and Back
adjustments.

Change Icon - If you are saving a custom layout you can change the icon graphic associated with the layout.
Carbonless Copies - Input the amount of carbonless copies you would like to print for a specific form.
Carbon # - Adjust settings for carbonless copies.
Form - Allows you to add custom forms and/or Letterhead. (Leave blank for no forms to print.)
Form only on first page - Only prints selected form on Page #1
Layout Description - Gives you a brief definition for the selected layout..
Save and Close - Saves any changes made to the current Layout.
Save As New Layout - Opens the Save As dialog box to save the layout with a new name
Use Factory Settings - Reverts all changes back to the original settings.
Help- Launches the help file.
Cancel - Closes the Modify Layouts dialog.

If you set the Book let Type to Poster (Windows XP, 2000, 2003, Vista, 7 only), you get other options:

Paper Orientation - This lets you choose the orientation of the pages in the poster.
Pages on Poster - This specifies how many pages will be printed per poster.  Across specifies the number of pages going
horizontally, and Down specifies the number of pages going vertically.
Poster Margins - The top and left margins specify how far over the poster will begin printing from the upper-left corner of the
first piece of paper.  In most cases it makes sense to leave these at 0, unless you are missing part of your poster because
of the non-printable area of your printer.
Poster Cropping - This will stretch your document to fit the poster in one direction and crop off the other dimension if the
document does not fit exactly.
Scaling (Width/Height) - This is the total width and height of the poster after assembly.
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Overlap - This specifies how much overlap in each poster page.  The pages intentionally overlap because most printers
cannot print to the edge of the paper so there would be white gaps on the poster.  You should trim off the white non-printable
area before taping the poster together.

4.5 Assemble a Booklet

To turn on the Assembly Instructions:

1. Click the Options button   on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and click in the box next to Print assembly instructions.
3.    Click OK.

4.6 Cutting And Assembling a Booklet

The cut marks on the printout are guidelines that show between which mini-pages to cut.  Their position is accurate to about
1/16", which is not high precision for very small mini-pages.  Use your eye or measure, in order to cut precisely halfway between
mini-pages.

The marks themselves tell you the order of the cuts.  The solid line indicates the first cut, the line composed of two dashes
indicates the second, the line composed of three dashes indicates the third, and so on.

The instructions below, or those printed with the printout, include the important information about how to re-stack the cut sheets
after each cut.  They give the general rules for cutting and assembling any book of any layout.

1. If the mini-pages do not fill the sheet (that is, if you specified absolute mini-page dimensions), the first step is to cut away
the extra paper.  If there is no extra to cut away, skip to step 4.

2. Cut at the "one-dash" cut mark, which indicates a vertical cut to eliminate extra paper on the right.  Discard the extraneous
strips.

3. Cut at the "two dash" cut mark, which indicates a horizontal cut to eliminate extra paper at the bottom.  Discard the
extraneous strips.

4. Make the leftmost vertical cut.  (Look for the next cut mark.  Depending on whether you did steps 1.a. and/or 1.b., this may
be composed of one, two or three dashes.)

5. Now your printout is split into two stacks.  Place the one with page 1 on top of the other, aligning the top left corners.
6. Make the leftmost remaining vertical cut, if any.
7. Again, place the page 1 stack on top of the other, with top left corners together.
8. Continue in the same way until all vertical cuts have been made.
9. Make the top horizontal cut.
10. Place the page 1 stack on top of the other, with top left corners together.
11. Make the topmost remaining horizontal cut if any.
12. Place the page 1 stack on top of the other, with the top left corners together.
13. Continue in the same way until all horizontal cuts have been made.
14. Be sure to fold and/or bind on the edge indicated by your choice of layout, namely binding on the left for a Standard book, or

on top for a Flip book.  For a folded booklet layout: Remove blank mini-sheets, if any, from the middle.  Fold in half and
staple.  For a cut book layout: Remove blank mini-pages, if any from the end.  Then bind.

Cutting options:
  Paper Trimmer - See our paper trimmers at http://www.bluesquirrel.com/so/trimmer/

http://www.bluesquirrel.com/so/trimmer/
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Binding options:
  Staple (also called a saddle stitch) - See our specialized staplers at http://www.bluesquirrel.com/clickbook/staplers.asp

4.7 Assembling a Poster

ClickBook makes poster creation easy (Windows 7, Vista, XP, 2000 only).  

Steps:
1. Print your document to ClickBook
2. Use Poster Wizard to create a poster of any size.
3. Click the Options tab on the toolbar. Select the Poster tab, and mark check boxes for instructions that you want printed.

Press OK to save changes.
4. Hit print from ClickBook to print to your printer.

Once you've printed your poster you will have a stack of paper.  ClickBook has been designed so that you should be able to take
the stack and lay the pages out from left-to-right and then top-to-bottom, the same way that you read.

We suggest that you trim off the excess white space.  The white space is because of the non-printable area of most printers. 
Once you trim off the white space, you can line up each page with its previous page and tape it together.

Options for fastening the pages together include:
Staples
Tape
Glue onto poster board
Staple directly to a wall or bulletin board

Trimming Hints:
You do not have to trim every side of every page because you can overlap the pages.  The pages are printed so that there is
some overlap.  This overlap helps you line up the pages.  By default, there is a one inch overlap for each poster page.  The non-
printable area takes up some of that one inch overlap, and should be trimmed off.  If you don't want any overlap, trim off exactly
one inch from the left side of each page (except the pages in the first column), and one inch from the top (except the pages on
the first row).

http://www.bluesquirrel.com/clickbook/staplers.asp


ClickBook Help File20

© 2010 Blue Squirrel

4.8 Creating a Banner

You can use ClickBook to create a banner of any size (Windows Vista, XP, 2000, Vista, 7only).  And you can use your favorite
program to make the banner.

Our example uses Microsoft Word, but you can also use WordPad which comes with Windows, or any other Windows program.

The key to creating a banner in ClickBook is to make your text go all the way across the paper in your source document.  The
easiest way to do this is to increase the font size until you've gone across the paper.   You should set the paper margins to 1/4
inch in Page Setup... in Microsoft Word to make sure you go all the way across the paper.

   

You can also make tall banners.  Have the text go down the left side of the page from top to bottom.

You are not limited to one line of text for your banners.  Just make sure the longest line goes all the way across the page.  Also
make sure you put your text at the very top of the page.

Steps:
1. Print your document to ClickBook
2. Choose the Poster Wizard
3. Choose Crop/Banner (1:1) from in the Poster Wizard
4. Choose how wide you want your banner, and how tall you want your banner 

Tip: When choosing how wide and how high you want your banner, keep in mind the shape of your banner.  In the example
above, you might make it 6 feet long and 1 foot high to keep the right shape.  Or 12 ft x 24" also works.  But 12 ft x 15" is not the
right shape and does not work.  See the examples below.  The width will always fit.  You should adjust the height of the banner
to make sure you don't chop off the bottom of your text.

6 ft x 12"   (RIGHT)

12 ft x 24"   (RIGHT)

12 ft x 15"  (WRONG)
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Tip: Center your text at the top of the page, and then increase the font until your text goes edge-to-edge.

4.9 Making a PDF file

ClickBook can make PDF files.  Choose your layout, and hit the PDF button  on the toolbar.  Name your PDF file and
choose Save.

The Save dialog has an option PDF Security... which lets you set an owner password, a user password and set limits on what
users can do with the PDF file.

 Auto Email PDFs - ClickBook will use your default email client to quickly send converted PDF files to friends, family,
and colleagues. You can use this feature to quickly email PDF booklets, PDF brochures, PDF banners, PDF posters, and
more. Simply click on the email button on the toolbar. Your default email client will open with the PDF as an attachment. You

can select the person you would like to send the PDF to, type in a message, and send the email as you always have. You
can now email using your SMTP Server settings. 

To setup your SMTP Server Settings.  

1- Go to .  
2- Then click on the 'Email Setting' tab. 
3- Click OK to save your settings. 
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4.10 Printing a PDF booklet

Printing a booklet from a PDF works best if you have a duplexing printer that prints automatically on both sides.  In the printing
options, set to "Flip on Short Edge"

4.11 Quick Click Printers

Quick Click Printers allow you to automate the printing process, and send print jobs directly to the printer without ClickBook
intervention. You can instantly print side-by-side folded booklets, convert to PDFs, or print flipbooks with a single click. You will
setup a ClickBook printer with your preferred layout. ClickBook will then make a custom Quick Click printer that is tied to your
printer and a specific ClickBook layout. The Quick Click Printer will always print the same way each time to your printer. You can
even setup a PDF Quick Click printer that will automatically convert files to PDFs, email them with your default email client, and
add any encryption or password preferences. No more hassle thumbing through all of the layouts, simply setup a Quick Click
Printer and let ClickBook handle the rest. By default there are two Quick Click Printers setup. "Side By Side Folded" prints
standard 8.5x11 side-by-side folded booklets, and the second "PDF Converter" converts files to PDFs.

To setup a Quick Click Printer follow these steps:

1. Open ClickBook and go to File, and select Quick Click Printers. The Quick Click Printers dialog will appear.
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2. Click on New  and type in a name for your custom Quick Click Printer.

3. Select a layout from the drop down menu.
4. Choose a radio button to Print Immediately or Open ClickBook.
5. Select your printer from the Print To drop down menu. Please note, If you would like to use the hand fed tray on your printer

you'll need to mark the check box next to the Print To drop down. If the hand fed tray option is greyed out you will need to
setup a standard ClickBook printer first with the hand fed option. See Automatic Printer Setup for instructions.

6. Press Close when you are done.

To setup a PDF Conversion Quick Click Printer follow these steps:
1. Open ClickBook and go to File, and select Quick Click Printers. The Quick Click Printers dialog will appear.
2. Click on New and type in a name for your custom Quick Click Printer.
3. Select a layout from the drop down menu. Note, if you want your PDF file to be a standard 8.5x11 size choose the layout "1-

UP (Fax) Portrait".
4. Choose a radio button to Print Immediately, which will convert to a PDF without opening ClickBook, or choose the radio

button to Open ClickBook.
5. Select the ClickBook PDF Converter printer from the Print To drop down menu. Doing so activates all options for the PDF

Settings.
6. Mark check boxes alongside the items, such as Save In, Email To, and Encryption that you wish to set custom

preferences. 

 Marking the check box for Save In allows you to set a specific location on your hard drive where you would like to save and
store PDF files.

 If you check the Email To box this allows you to enter an Email address that you will frequently send PDF files to, and the
Email Message section allows you to type a text message to the receiver. NEW! You can now add a subject line in your
Quick Click Printer emails.

 Marking the check box for Encryption gives you options to set a password and ask for the password, detect whether you
want 40Bit or 128Bit encryption, and assign rights to viewers. Mark the check box Change PDF if you want viewers to have
the right to edit the PDF. Mark the check box next to Print PDF if you want viewers to be able to print the PDF. Mark the
check box Copy Text if you want readers to have permission to copy and paste text. Mark the check box for Add Notes if
you want give readers the option to add notes to the PDF file. 

7.   Click Close to exit the Quick Click Printers dialog box.

***NEW***: You can now Activate and Inactivate Quick Click Printers. This allows you to have multiple Quick Click Printers
setup, without having all the printers listed in your printers folder.

***NEW*** When you setup a PDF Quick Click Printer with 'Auto Name' ClickBook will now intelligently save the same file(s) by
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adding alphanumeric characters to the end of the file name. (Example: README.pdf, README-0001.pdf, README-0002.pdf)

5.1 Forms and Letterhead
0

ClickBook has the ability to create electronic forms and letterhead.

After you create a form in ClickBook you can set ClickBook to use that form in the Modify layouts screen. The ClickBook preview
feature will show how your output will appear before you print it. This ensures that your document is aligned correctly with
the form you have selected.

ClickBook comes with 3 sample forms/letterhead:
1. Blue Squirrel Letterhead.cbf
2. Purchase Order.cbf
3. Sample Background.cbf

How to create a form:
1. Create a form in a separate application, like you would a normal document (1 page only), then print it to ClickBook.
2. Select the layout named: 1Up(Fax)
3. Then go to File> Save As Form.
4.    The Save As dialog will Open, and it will default to your My Documents folder.  
5.    Browse to the directory you want to save the form to.  
6.    Name the form and click Save.  

 
How to select a form to print in ClickBook 

To select a form to print in ClickBook, select the form from the Modify Layouts screen. 

1.  Print your document to ClickBook 
2.  Select the layout you want to print with. 
3.  Go to Layouts> Modify Layouts (or right click on the preview and go to Modify Layouts.) 



Advanced Options 25

© 2010 Blue Squirrel

4.   Click on the 'Browse' button next to foms to select the form you want to print with the selected layout. (This form will be
associated with this layout each time until you remove the form.) 
5.   Browse to the location you have your ClickBook forms saved to. 
6.   Select the Form to use and click Open.
7.   Check the preview to ensure that your form looks correct.  
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TIP: You can setup Quick Click Printers to use Forms as well, simply set the form in the layout that you are using for the Quick
Click Printer. 

5.2 Insert A Header

You can add a header to the top position of each mini page.  You can select a separate font, color and size for each type.  We
have also provided four buttons that will insert the print job name, date, time and page number into the header.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of 4
when used on a mini-page that is 4 times smaller than a regular sheet of paper.  This makes it easy to set up a header, footer, or
watermark that can be used for different booklet types as the text will be automatically sized for each booklet.
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To place a Header on your current print job follow these steps:  

1. Click the Options button on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers tab.
3. In order to print a header a check must be placed next to the Print Headers field.  Note:  Header can be permanently shut off

by un-checking the "Print Headers" checkbox.
5. Type your message in the text field box and/or select any of the following buttons

Job: places the title of the first print job listed in the Print Job window.
Date: Places today's date.
Time: Places the current time.
Page: Places the page Numbers.

6. To change the look and feel of the Header click the Select Font button. The Font window will open and from here the Font,
Font Style, Size, Effects, Color, and Script can all be changed.  The Sample window will demonstrate how the changes will
appear.

7. The Text justification allows you to choose where the Header will be placed: right, left, or center.   Place a mark next to the
desired position.

8. The Start printing Headers on page option allows you to choose which page the Headers will begin.  Note:  This feature
allows you to start the process of printing Headers on the mini-page of your choice.  This is useful for when you have a cover
page and you don't want the page number to be printed on that page.  Please note that the page numbering will start on the
page you choose.  For example if you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers on page option allows you to choose which page the Headers will end.  Note: The default setting
of 0 will end the printing of Headers on the last page.

10. Click Apply Changes to view any modifications you have made to your headers.  The changes will appear in the print preview
window.  If the changes are acceptable Click OK. Headers will now be placed on your print job.

Note: Headers are not printed on posters.

5.3 Insert A Footer

Adding a Footer will place a line of text in the bottom position of each mini-page.  You can select a separate font, color and size
for each type.  We have also provided 4 buttons that will insert the print job name, date, time and page number into the footer.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of 4
when used on a mini-page that is 4 times smaller than a regular sheet of paper.  This makes it easy to set up a header, footer, or
watermark that can be used for different booklet types as the text will be automatically sized for each booklet.

To place a Footer on your current print job follow these steps:  

1. Click on the Options button on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers, Footers, and Watermarks tab.
3. In order to print a header a check must be placed next to the Print Headers, Footers,  & Watermarks field.  Note:  Header,

Footers, and Watermarks can be permanently shut off by un-checking the "Print Headers, Footers, & Watermarks "
checkbox.

4. From the drop down menu select Footer.
5. Type your message in the text field box and/or select any of the following buttons:

Job: places the title of the first print job listed in the Print Job window.
Date: Places today's date.
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Time: Places the current time.
Page: Places the page Numbers.

6. To change the look and feel of the Footer click the Select Font button. The Font window will open and from here the Font,
Font Style, Size, Effects, Color, and Script can all be changed.  The Sample window will demonstrate how the changes will
appear.

7. The Text justification allows you to choose where the Footer will be placed: right, left, or center.  Place a mark next to the
desired position.

8. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers,
Footers, and Watermarks will begin.  Note:  This feature allows you to start the process of printing Headers, Footers, and
Watermarks on the mini-page of your choice.  This is useful for when you have a cover page and you don't want the page
number to be printed on that page.  Please note that the page numbering will start on the page you choose.  For example if
you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.

9. The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers Footers,
and Watermarks will end.  Note: The default setting of 0 will end the printing of Headers, Footers, and Watermarks on the
last page.

10. Click Apply Changes to view any modifications you have made to your headers, footers, or watermarks.  The changes will
appear in the print preview window.  If the changes are acceptable

11. Click OK. Footers will now be placed on your print job.

Note: Footers are not printed on posters.

5.4 Insert A Watermark

Adding a Watermark will add a graphic or text in the diagonal position of each mini-page.  You can select a separate font, color
and size for each type.  We have also provided 4 buttons that will insert the print job name, date, time and page number into the
watermark.

Job – <job> inserts the name of the first job listed in the Print Job bar
Date – <date> inserts the current date the job was printed using this format "month dd, yyyy"
Time – <time> inserts the current time the job was printed using this format "hh:mm AM/PM"
Page –  <#> inserts the current mini-page number

The fonts are scaled to match the mini-page they are used on; for example a 36 point font would be scaled down by a factor of 4
when used on a mini-page that is 4 times smaller than a regular sheet of paper.  This makes it easy to set up a header, footer, or
watermark that can be used for different booklet types as the text will be automatically sized for each booklet.

Note: Watermark graphics must be in bitmap (.bmp) format.  The graphic colors will not be changed in any way and will appear
the same way it does in your graphic editor.  You may want to lighten up the graphic before using it as a watermark so the text in
front of it does not get washed out.  You can do this with most graphic editors and word processors.   ClickBook uses a point for
point system for sizing the graphic and will allow you to scale the watermark from 10 times its original size to 1/10 its original
size.  For example, a 600 by 600 pixel graphic would be 1 inch on a mini-page using a 600 dpi (dots per inch) printer. To make
the graphic 2 ½ inches or 2 ½ times bigger enter 2.5 in the edit box below the Graphic button. 

To place a Watermark on your current print job follow these steps:  

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Select the Headers, Footers, and Watermarks tab.
3. In order to print a header a check must be placed next to the Print Headers, Footers,  & Watermarks field.  Note:  Header,

Footers, and Watermarks can be permanently shut off by un-checking the "Print Headers, Footers, & Watermarks "
checkbox.



Advanced Options 29

© 2010 Blue Squirrel

4. From the drop down menu select Watermark.
5. Now select the desired radio button to include a Text or Graphic Watermark.
6. If Text has been chosen you may now decide what information is to be placed in the Watermark.  Options include placing

the following:
Job: places the title of the first print job listed in the Print Job window.
Date: Places today's date.
Time: Places the current time.
Page: Places the page Numbers.
Textbox: Type text as you want it to appear. 

7. To change the look and feel of the Watermark click the Select Font button. The Font window will open and from here the
Font, Font Style, Size, Effects, Color, and Script can all be changed.  The sample window will demonstrate how the
changes will appear.

8. If Graphic has been chosen you can browse to the location of the image and select it or type the location of the image in the
text field.  

9. The Scale watermark graphic times the original size field allows you to make the image larger or smaller as desired.
10. The Start printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers,

Footers, and Watermarks will begin.  Note:  This feature allows you to start the process of printing Headers, Footers, and
Watermarks on the mini-page of your choice.  This is useful for when you have a cover page and you don't want the page
number to be printed on that page.  Please note that the page numbering will start on the page you choose.  For example, if
you start on page 3 it will be numbered as 1, page 4 will be 2 and so on.   

11. The Stop printing Headers, Footers, and Watermarks on page option allows you to choose which page the Headers Footers,
and Watermarks will end.  Note: The default setting of 0 will end the printing of Headers, Footers, and Watermarks on the
last page.

12. Click Apply Changes to view any modifications you have made to your headers, footers, or watermarks.  The changes will
appear in the print preview window.  If the changes are acceptable click OK. A Watermark will now be placed on your print
job.

Note: Watermarks are not printed on posters.
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5.5 Add Page Numbers

To Add Page Numbers to your ClickBook printouts follow these steps:

1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select Options.
2. In the Options dialog box click the box next to Print Headers, Footers, & Watermarks.
3. Click the Page button. ClickBook will place the code <#> in the text box.  You can add any additional text you want to

appear before or after the page number.
4. Click OK.  Page numbers will now be placed in the top center position on each mini page for your print job.

5.6 Add A Border

1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select Options.
2. In the Options dialog box click on the Paper, Borders tab.
3. In the Borders box you can select the type of border you want and the thickness of the lines.
4. Click OK.  A border will now be placed around your print job.

***NEW*** ClickBook now has diagnostic borders to see if the pages are aligned properly.

Note: Borders are not printed on posters.
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5.7 Drag And Drop

Once you've created a shortcut on your desktop, or on your Windows task bar to the ClickBook Printer you can easily select
files, and drag and drop them onto the ClickBook Printer icon.  Then ClickBook will automatically launch the program the file was
created in, and print the file to ClickBook .  This is a great way to speed up the printing process. 

To place a ClickBook Printer Shortcut on your desktop  please follow these steps:

1. From the Start Menu, select Settings, then Printers. The Printer dialog box appears with a list of your printers. 
2. Select the ClickBook  Printer, right click, and click on Create Shortcut.
3. Windows will ask you if you want to create the shortcut on your desktop. Click Yes. 
4. If you do not receive the Windows message simply activate your desktop, right click, and select paste shortcut. 

Wonderful! Now you can simply drag documents onto the printer icon  to print using ClickBook .

To place a ClickBook  Printer Shortcut on your taskbar please follow these steps:  (Please note: in order to create a shortcut on
your Windows Taskbar you must have version I.E. 4.0 or later.)
1. Click on My Computer, and select Printers or from the Start Menu, select Settings, then Printers.  The Printer dialog box

appears with a list of your printers. 
2. Select the ClickBook Printer.
3. Click and drag the file onto your taskbar.

Congratulations! Now you can easily Drag & Drop files onto your ClickBook Printer on the taskbar to quickly print booklets.

NOTE: Drag and Drop does not work in Windows 7.

5.8 Instant Print

Instant Printing, or 1-step printing automatically starts the printing process without ClickBook program intervention. For example,
if you chose to print a document in Microsoft Word ClickBook would automatically print the file as a booklet without opening the
ClickBook software.  

If you have already printed a document once, and print it again using ClickBook it will use the same layout settings previously,
such as, double-sided portrait to print the job. If you elect to print a different document ClickBook refers to the default layout
setting, which is double-sided booklet to print the job. 

To enable Instant Printing please follow these steps:

1. Click on the Options button  on the Toolbar, or click Tools on the Menu bar and select Options.
2. In the Options dialog box click on the Program Settings tab, and mark the Instant Printing check box.
3. Click OK.  Instant Printing is now enabled! 

NOTE: ClickBook will open briefly then close when using Instant Printing, it will not allow you to change the layout.
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5.9 Delete A Page

Delete A Page removes pages from a booklet.  This feature comes in handy when you're printing Web pages to eliminate the last
web
page with only footer information.

To Delete a Page follow these steps.

1. Go to Tools on the menu bar and select Delete a Page…
2. The Delete a Page dialog box appears.
3. Enter the page numbers for the pages you wish to delete in the text box. Refer to the red number located on the document

in the Print Preview window.

OR

1. Right-click on a page in the Print Preview screen and select Delete this page.
2. A confirmation dialog will pop-up asking you to confirm the deletion. Click Yes to continue and delete the page.

5.10 Print A Table Of Contents

ClickBook will add a Table of Contents to the beginning of your printout that will list the names of the files located in the Print
Jobs menu, and the page number where each file starts printing.

To print a Table of Contents:

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled Print a Table of Contents Page.
3. Click OK, and ClickBook will add a Table of Contents to the printout.
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5.11 Print without Images

ClickBook now has the ability to remove images from the print job, allowing you to save ink when printing from Web Pages.

To remove images from a print job:

1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled 'Print without images'.
3. Click OK, and ClickBook will will remove images from the print job.

5.12 Reverse Printing

ClickBook can now print 'Hebrew Booklets' by utilizing the 'Reverse Printing' option.

To use reverse printing 
1. Click on the Layouts> Modify Layouts. This will bring up the Modify Layouts dialog box.
2. Check the 'Reverse Printing' check box.
3. Click O.K. and ClickBook will now print your documents in reverse order.

NOTE: Reverse printing is not available for all layouts.
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5.13 Adjustable Mini-pages

Use the Adjustable Mini-Page feature to reposition your document within the layouts mini pages, or enlarge the font. You will
input how far left/right and up/down you want to reduce the mini-page margins to enlarge text and graphics. NOTE: Adjusting mini
pages may cause clipping of fonts if they are adjusted too much.

To use this feature proceed with the following steps:
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1. Click on the Options button  on the toolbar.  This will bring up the Options dialog box.
2. Choose the Print Settings tab and place a check in the box entitled Enable Adjustable Mini-pages.

3. Click OK, and ClickBook will enable Adjust Mini-page button  in the Modify Layout dialog box.
4. From the Menu bar open Layouts and select Modify Layout.  The Modify Layout dialog appears.
5. Choose the Adjust Mini-page button under Margins. The Adjust Mini-Page Dialog appears.

6. Adjust the Margins to your liking.  For example, to print an enlarged booklet with centered text you'll reduce the position
by .5 inch up, and to the left. The you'll need to compensate for the bottom and right margins by reducing them 1 full inch.

2. Mark the check box next to Apply position 1 adjustments to all mini-pages if you want the adjustments to appear on all
pages of your booklet.

3. Press OK. Review the changes in the Print Preview, and repeat steps 1 through 6 to further adjust.

You will see a small icon next to the adjust mini page button, if the mini pages of the selected layout have been modified.
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5.14 PDF Settings

AutoName - If you check this option, you will not be prompted to name the PDF file.  The name will be derived from the name
of the document that you printed first.  

Don't prompt when writing over a file with the same name - Check this option when you would like to replace previously created
PDF files with new PDF files.  This option usually goes with AutoName.  Then when you create a new PDF with the same
name, the old one will be overwritten.

 Multi-Language Support (Unincode characters) - Allows you to convert unicode fonts, common with different
languauge fonts. Also allows you to convert 'Smart  Quotes' . 

Optimize the PDF file for the web - This option creates a PDF file that will load into a browser in stages.  The first page will be
available to read while the other pages are still loading.

Change the colors to grayscale in the PDF file - This converts color documents to greyscale documents.  Sometimes it is
easier to print a greyscale document on black and white laser printers.

Open PDF file after creation - This launches the PDF viewer so you can see the created document after printing.
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5.15 Carbonless Printing

Carbonless Printing - This is a fantastic feature we've added to ClickBook. Now you can print carbonless forms with any
number of copies per form. ClickBook also handles the sub numbering on the form and can print the numbers as a header or
footer. 

To activate Carbonless Printing follow these instructions.

1. Print a file to ClickBook, and the ClickBook dialog appears.
2. On the menu bar select Layouts, and go to Modify Layout. The Modfiy Layout dialog appears.

3. Click on the  Carbon # box in the right hand corner of the screen to setup printing options.

4. Choose the number of Carbonless Copies  you would like to print for each form.

Note: To set specific rules for Carbonless printing click on the Carbon # box. 

Click the Select Font button  to change the font size, style, and type.

Fill in the blank text box  with items you want to print on forms. Use
this numbering system:

<> - these greater than, and less than signs enclose the number format.
Use << to print a < #### - this prepends zeros to the number so <####> = 0001 
^̂  ̂- this adds a number for each mini page in the carbon copy so <#### - ^̂ ^> = 0001 - 001, 0001 - 002, 0001 - 003... 
date - adds a the date in the format of month day, year so <date> = September 21,2006 
time - adds the current time in the format of hours:minutes AM/PM so <time> = 10:48 AM 
job - adds the first job name listed so <job> = Microsoft Word - Readme File 
<d> - Day of month as digits with no leading zero 
<dd> - Day of month as digits with leading zero 
<ddd> - Day of week as a three-letter abbreviation 
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<dddd> - Day of week as its full name 
<M> - Month as digits with no leading zero 
<MM> - Month as digits with leading zero 
<MMM> - Month as a three-letter abbreviation 
<MMMM> - Month as its full name 
<y> - Year as last two digits, but with no leading zero 
<yy> - Year as last two digits, but with leading zero 
<yyy> - (should not happen) get 2 year strings y and yy 
<yyyy> - Year represented by full four digits 
<h> - Hours with no leading zero for single-digit hours; 12-hour clock. 
<hh> - Hours with leading zero for single-digit hours; 12-hour clock 
<H> - Hours with no leading zero for single-digit hours; 24-hour clock. 
<HH> - Hours with leading zero for single-digit hours; 24-hour clock. 
<m> - Minutes with no leading zero for single-digit minutes. 
<mm> - Minutes with leading zero for single-digit minutes. 
<s> - Seconds with no leading zero for single-digit seconds. 
<ss> - Seconds with leading zero for single-digit seconds. 
<t> - One character time-marker string, such as A or P. 
<tt> - Multicharacter time-marker string, such as AM or PM.

Persistent Number  allows you to input a number to print on invoices. -1 will not print a
number. If you input 3283, the following invoices will print as 3284, 3285, and so forth. Each time you print to that specific
layout in ClickBook, it will keep track of the number for you.
Exact Text Position gives you flexibility to place the invoice number, date, time, year, etc. on a specific place on the page. For
example, if you want the invoice number to print in the bottom center of the page, change the horizontal position to 50% and
select the radio button to Place the text on the postion. The default position is set to print in the bottom left hand corner of the
page. 

Click OK to save changes, and Cancel to abort changes.

6.1 Types Of Layouts

This topic will be easy to understand if you read it while looking at ClickBook's Print Preview screen.  Select various layouts in
turn, and compare each one.

What is a Layout?
A layout is a blueprint for a particular booklet, which is defined by a group of detailed settings that tell ClickBook how to arrange
the mini-pages on a sheet of paper.  Some of the essential details are whether the paper orientation is portrait or landscape, how
many mini-pages are printed across and down on one sheet, whether to print single or double-sided, margin sizes, and added
space for binding.

Booklet Styles
Each layout also has a certain booklet style.  This relates to how you intend to assemble and bind the booklet, and tells
ClickBook the order to print the mini-pages so they will end up in the right order in your finished booklet.  There are six booklet
styles: Cut book, Folded book, French fold, Planner pages, Tiled, and Tri-fold.  You can determine a layout's booklet style by its
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name, the corresponding picture, and by looking at the Booklet Style in the Modify Layouts tab.

 Cut book Layouts are for methods of binding that require cutting between facing pages.  Most of the cut book
layouts shipped with ClickBook are designed for paper that's pre-perforated for a custom appointment-book page.

Folded book Layouts are designed for folding between facing pages, and stapling.  Examples include the "Address
book (folded)", "Wallet book (folded)", and "Side-by-side (folded)" layouts.

 French fold layouts are for making greeting cards from standard paper by folding the printed sheet in fourths.   The
French fold style expects exactly four pages per sheet.

 Planner page Layouts are designed for day planner paper that has holes on the left and right hand sides.

 Posters are designed to expand one page onto multiple pages to make it larger.  It requires some trimming and
taping, but you can make some impressive posters.

 Tiled layouts are designed for multiple pages on a sheet but not cutting the sheet.  The sheets that come out of
the printer are the final sheets.  There are two sequences in which the mini-pages can be printed in a tiled layout.  These are
controlled by the Binding Orientation options in the Modify Layouts dialog.

Row-wise means page 2 prints to the right of page 1.  For row-wise order, select the Standard binding orientation.
Column-wise means pages 2 prints below of page 1.  For column-wise order, select the Flip binding orientation.

Tri-fold Layouts are for printing single-sheet brochures or leaflets which are folded twice, making three panels (mini-
pages) on each side of the paper.   The tri-fold style expects exactly six pages per brochure, since this style of brochure is a
single sheet of paper, folded.  Tri-fold pagination places pages 5, 6, and 1 on one side, and pages 2, 3, and 4 on the other side.
 The front panel is thus page 1, and the reader opens up the brochure to see pages 2, 3, and 4 inside, and then turns the sheet
over to read pages 5 and 6.

6.2 Selecting A Layout

Answering the following series of questions will help you decide which layout you want.  

Is your document oriented as portrait or landscape?  You should choose a layout that orients the mini-pages in the same
way.  Look at the picture for each layout to determine its mini-page orientation.  (ClickBook will warn you if you choose a
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layout that doesn't match.
What sort of booklet do you want to print? 
How large do you want your finished mini-pages to be?  Mini-pages determine how many pages you want to include on a
single sheet of paper, and how to fit them on the size of paper you're using.  For examples look through the tiled or booklet
layouts.  To choose a layout with an appropriate number of mini-pages, look at the print preview picture. 
What size do you want your fonts and graphics to appear?  Small booklets usually require that you enlarge the fonts and
graphics, unless you choose to use No Scaling.  If you choose No Scaling enlargement must be done in your application
program and then print the document to ClickBook again.  If you want to enlarge the fonts in ClickBook refer to adjustable 
Mini-pages.

To Select a Layout:

1. Print your document to ClickBook.  For step-by-step instructions refer to Printing Your First Booklet.
2. In the Print Preview screen Browse through the Category drop down menu to quickly find layouts that match your document

type.  For example, if you're printing a side-by-side folded booklet choose the Books category.  Or if you're printing your
contact list to insert in your Day Planner, choose Personal Organizers, or Franklin Covey Paper.

3. Use the Layout drop down menu to browse through the available Layouts, and select one that matches your document.
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4. To see the settings for a particular layout, select Layouts on the Menu bar and click on Modify Layouts.

6.3 Modifying A Layout

To modify an existing Layout proceed with the following steps:

1. Print your document to ClickBook.  For step-by-step instructions refer to Printing Your First Booklet.
2. From the menu bar open layouts and select either or Modify Layout. 
3. The Modify Layout dialog appears.  Choose a Layout from the drop down menu that are similar to what you want.

4. Make desired changes by adjusting margins, scaling, mini-page margins, how many mini-pages you would like to appear on
a single sheet of paper and so forth.  

5. Click Save As new Layout to save your changes to a new layout or Save and Close to replace the old one. Click Use
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Factory Settings to revert back to  the layouts original settings. 
6. Examine your changed Layout in the Print Preview picture to see how your document is affected.  If you are satisfied with

how the booklet looks, click Print.  If you are not satisfied repeat steps 2 through 4 to further adjust the layout.

7.1 Printing Multiple Copies Sequentially

To print multiple copies of the same print job:

1. As usual, print from your application program to a ClickBook printer.
2. When ClickBook pops up, set the Num of copies option.
3. Click Print.  ClickBook prints the first sides of all copies, with a single instruction sheet.
4. After the first sides of all copies have finished printing, put the whole printout stack back in the printer.
5. Click the Print Second Side button.
6. After the second sides of all copies have finished printing, separate the copies.
7. Cut, assemble, and bind each booklet individually.

Note: If you want to print multiple identical booklets, follow the instructions above.  Setting multiple copies within your application
program will not work correctly.

7.2 Previewing The Printout

The Print Preview lets you see how your document will look when printed with the selected layout.  It is not accurate in every
detail, and your actual printout will look better than the preview.  But the Print Preview enables you to see most features of the
printout, such as:

How mini-pages are positioned.
The relative sizes of margins and data.
How many sheets will print.
How many blank mini-pages will be printed at the end.

Zoom in on a mini-page by clicking on the mini-page or right-click and choose the zoom level up to 800%.  Repeated clicks will
zoom in closer and closer until 800% is reached and then another click will take you to the full sheet view.

You can also zoom with the scroll wheel on your mouse.  Position the cursor over the preview window and scroll the wheel to
zoom in and out.

Note:
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Use the bar beneath the picture to navigate to different sheets of the booklet:
To go to the first or last sheet, click the arrow button at the left end or right end of the bar.
To go to the next previous sheet, drag the slider button left or right.  When the desired sheet number is shown, release the
mouse button.
To go to the next or previous sheet click the bar on the left or right side of the slider, depending upon which way you want
to go.

Use the front and back buttons to see the other side of the currently displayed sheet.
Use the Sheet selection to select a sample sheet to print for 100% accuracy.  

7.3 Reinserting The Print Out Stack Before Printing The Second
Side

The critical step of double-sided printing is correctly reinserting the first-side print out correctly into the printer so the second side
can be printed.  Each detail of this process is important:

When you are certain that all of the sheets from the first-side printout are done, remove the printout stack from the printer
without rearranging the pages.  Make certain that if any other print jobs were sent to this printer, that you are holding only
your intended printout.  If you're on a network and a printer prints an extra sheet (blank, or with network user id, for example)
between printouts, throw out that sheet.
Turn the stack over if necessary to find the instruction sheet.  Read the instruction sheet without lifting it off the stack.
Reinsert the stack with the instruction sheet still on it.
If your printer puts out an extraneous sheet before each print job ( e.g. printout separator sheets on network printer), place a
blank sheet on top after reinserting the stack.  If the printer went offline when you reinserted the stack, put it back online.

7.4 Return To ClickBook After Printing

With the Return to ClickBook after printing option is turned on, ClickBook will remain open after printing is complete allowing you
to:

Reprint a sheet or a range of sheets.
Save the booklet just printed as a .cb file.
Print the document as a different layout.
Modify the layout and print the document again.

You can turn this feature on temporarily for the current print job, or permanently for all future print jobs.

Follow these steps to enable this feature :
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1. From the Toolbar choose the Options button .
2. The Options dialog box appears, select the Program Settings Tab.
3. Mark the checkbox next to Return to ClickBook after printing.
4. Press OK.

Follow these steps to enable this feature for temporarily:
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1. Print file(s) to ClickBook. 
2. Click the Print button to send the Print Jobs to the printer.
3. While the booklet is printing ClickBook will quickly display a status screen, mark the check box to Return to ClickBook after

printing. (Be aware: this pops up and closes fast.)
4. ClickBook will re-open.  This feature will remain on for the current print job.

7.5 Print A Range Of Sheets

Sometimes you want to print only a part of a booklet, for reasons such as:

Before printing the whole booklet, you want to print a sample sheet to see how it looks.
A sheet of paper jammed in your printer or came out creased.
After printing, you needed to make a small change that affected just a few pages of your document and did not change the
pagination.
Sheet #3 fell on the floor and the dog ate it…

Whatever the reason, you can reprint just the affected sheets, rather than the entire print job.  Here's how:

1. Click the Sheet Selection button.
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2. Specify the range of sheets to be printed by setting First Sheet and Last Sheet.  You must specify the first and last sheet
by number.  Note: You can print one sheet or a continuous range, but not discontinuous sheets (like 1 and 4).  

3. Choose the desired option for printing fronts and/or backs of the sheets.  Also choose whether or not to print the instruction
sheet.

4. Click Print to begin printing.

Note: Refer to Previewing the Printout to learn how to navigate different parts of the booklet in the Print Preview Screen.  Refer to
Return to ClickBook After Printing to prepare for the possibility of having to reprint a booklet before it finishes printing.

7.6 Hand Fed Tray Printing

Hand Fed Tray printing was specifically designed to make it easier to print on LaserJet non duplexing printers, meaning a
printer that does not print on both sides of the paper automatically. This feature allows you to put the second side of the paper
into the Hand Fed tray for printing, instead of pulling out the main paper tray, reinserting the paper, and then reinserting the paper
tray. The Hand Fed tray option also makes it 100x easier to print on different paper sizes such as legal paper. 

1. To use this feature you must first setup a Custom Printer with the Hand Fed Tray Paper Path. Go to Custom Printer Setup

and follow the instructions. Ensure that you check the box  in the Custom Printer
Setup wizard. Once you have setup a custom printer proceed with the following instructions.

2. Print a file to ClickBook, and the program will open.
3. Choose your printer from the drop down.

4. Mark the check box "Use Hand Fed Tray"  and press Print.

8.1 Setting Margins And Binding Space

Margins
Paper margins allow you to change the margins for a sheet of paper, and Mini-Page margins allow you to change the mini-page
margins for the current Layout.

Important:
ClickBook's margins are in addition to the margins set in your application program.
Unlike the application program's margins, which gets scaled down along with the contents of your document, ClickBook's
margins print at the exact size specified.

To change either margins follow these steps:

1. From the Menu bar select Layouts and click on Modify layouts.  
2. Under the Margin section alter the settings to your liking by using up and down arrows on the number boxes.  To make a big

increase or decrease, hold the mouse button down  until the desired value is reached.
3. View the results by watching the Layout picture, which redraws automatically to show the margin changes.  The margins,

including the Binding margin are shown in blue. 
4. When you are finished, press Done.

Note: Usually you should set your application program's page margins or ClickBook's Top/Bottom and Left/Right Mini-page
Margins.  If you choose to set ClickBook's we recommend that you first print a part of your booklet and measure the exact of
margin you want to add.  Then print the entire document with the Mini-page margins set correctly.

Note: Set the Paper Margins to match the cut-away or pre-perforated tear-off areas around the edges of some custom papers.

Binding 
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The Binding margin is extra space only on the side where the book will be bound.  You can adjust the following:
Printer Paper Size - Select the size of paper you want to use.
Binding Edge - Choose how you want the binding edge.
Print Sides - Select to print on one side or both sides of paper.

To change Binding.
1. From the Menu bar select Layouts and click on Modify layouts.  
2. Under the Binding section alter the settings to your liking. 
3. When you are finished, press Done.

8.2 Printing Sub-booklets To Bind Together

Sub-booklets or commonly referred to as Signatures are printed pages that are folded and then trimmed, and stacked with other
sub-booklets or signatures to make a book. An A 6 page signature would be the same ClickBook's 24-page sub-booklet when
using the side-by-side folded layout. 6 pieces of paper when folded makes a 24-minipage book.

Rather than folding a whole booklet together, you may wish to print and fold sub-booklets or signatures separately, and then bind
them together.  
Reasons for using Signatures or sub-booklets include:

To avoid shingling or margin creep that otherwise occurs with thick folded booklets.
To meet the needs of special binding methods.
To separate individual documents from a mail-merge print stream.

To enable ClickBook's Sub-booklet feature:

1. From the Menu bar select Layouts and click on Modify layouts.  
2. The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to Sub-booklets.
3. Use the up and down arrows next to Pages-per to set the amount of pages each sub-booklet will contain.
4. When you are finished press Done.

8.3 Printing On Legal Size Paper

If your printer tray allows you to input and print legal size paper please proceed with the instructions below. If your printer must be
handfed with legal size paper to print please ensure you follow the instructions to setup a custom printer to use the hand fed tray.
See Hand Fed Tray Printing.

1. Once you have setup your printer print the file from its application to ClickBook. 
2. Choose Books from the Layout drop down, and Side-By-Side Legal (folded) from the Layouts drop down.

3. Mark the check box Use Hand Fed Tray. 
4. Select the printer, and press Print.

NOTE: You can also select Legal Size Paper from the Modify Layout window.

8.4 Repeat

The effect of Repeat depends on the current Layout.  Repeat can be used to print more copies when there aren't enough mini-
pages to fill the sheet.   Repeat can also be used, alternatively, to avoid the step of assembling multiple booklets.  ClickBook
contains two Layouts with Repeat turned on, they are the Business card layouts and Greeting card (heavy stock repeat) layouts.

To activate Repeat proceed as follows:

1. From the Menu bar select Layouts and click on Modify layouts.  
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2. The Modify Layout dialog box appears. Under the Sub-booklet section mark the checkbox next to Repeat.
3. When you are finished press Done.
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Glossary

Aspect Ratio - The ratio of width to height.  If the aspect ratio changes then photographs can appear stretched or squeezed.
Banner - A Poster that is significantly wider than it is tall.  Constructed by taping multiple pages together, it usually
announces happy events like birthdays, homecomings, and graduations.
Binding Edge - A standard binding edge is for right/left.  A flip binding edge is for folding top/bottom.
Crop - Cropping chops off portions of a document.
Duplex - Printing on both sides of the paper.  Many printers include a duplexer that allows the printer to print on both sides of
the paper without human intervention.  ClickBook supports printers with duplexers.
Header - Text that will be printed at the top of every mini-page.  It may include page numbers, job name, date, etc.
Footer - Text that will be printed at the bottom of every mini-page.  It may include page numbers, job name, date, etc.
Forms - Electronic forms and letterhead for printing with different layouts
Landscape - A paper orientation where the words on the page are going across the long edge of the paper.  See Portrait.
Layout - A specific configuration of ClickBook that turns a print out in to a poster, booklet, card, brochure, etc.
Mini-Pages - The area on a piece of paper that the source document pages will be placed.  Example: One piece of paper
would have 4 mini-pages for a folded booklet.  Two mini-pages on each side of the piece of paper.
One-to-One - A Scaling option that keeps the shape.  This scaling option is better for photos.
Overlap - When printing Banners or Posters, some extra is printed on each page to allow easy alignment of the pages when
assembling the poster or banner.
Portrait - A paper orientation where the words on the page are going across the short edge of the paper.  See Landscape.
Poster - A large format print out which is constructed by taping pages together.
Poster Wizard - A quick easy way to create a custom poster.  For more fine control, use Modify Layout.
Sample Document - A document that works with a set of layouts.  The many samples included with ClickBook show how the
document works with ClickBook to create a print out.
Scaling - Stretching or shrinking a document to fit an area on a piece of paper.  One-to-one scaling will keep the aspect ratio.
Stretch-to-Fit - Stretches the source document to fit the new area.  If the area is not the same shape, the document may need
to be stretched more in one direction.  This is usually fine for text, but leads to photos that may look stretched or squeezed.
Sub-booklets - Breaking a full booklet print job into smaller booklets that can be individually folded, stacked and bound.
VIP Key - A key that removes the trial stamps and fully activates the software.
Watermark - A graphic that is printed on every mini-page.  This can be used for document authenticity, or to print a company
logo.
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Technical Support

If you are having difficulties using ClickBook, please check the following:

The problem may be with the printer.  See whether the problem still occurs when you (A) print without ClickBook, or (B) print on a
different printer.  If the problem still occurs in case A, or goes away in case B, the problem is with your printer or its driver.  The
first possible solution is to get a newer printer driver.  If no newer driver is available, or using the latest one does not solve the
problem, contact the manufacturer or vendor of your printer.

Frequently, problems observed in applications actually are based in the operating system.  Does your problem occur in other
applications as well?  Do any other symptoms suggest that the problem may be in Windows?  If so, you need Windows
technical support. 

Read the accompanying ReadMe.rtf file for any late breaking information about ClickBook, and using ClickBook with specific
software or hardware. You can access the ReadMe file by going to your Windows Start Menu. Then Select Programs, Blue
Squirrel, and ClickBook ReadMe. Please note this is the default location, your ReadMe file may be stored elsewhere.

Visit Our Web Site
 

If you cannot find the information you need in any of the preceding sources, contact us at our Web site.  Please refer to
ClickBook's support and FAQs for frequently asked questions.  http://www.bluesquirrel.com/support/

Contact Us
If you would like to speak with a  representative regarding a non-technical question please call Customer Service at:

Blue Squirrel Customer Service
Toll Free: 800-403-0925
Telephone: 801-352-1551
Fax: 801-912-6032
E-mail: sales@bluesquirrel.com

Note: Hours are: 8:00 a.m. to 5:00 p.m. Mountain Standard Time.

Blue Squirrel Mailing Address
Blue Squirrel
686 E. 8400 South
Sandy, UT  84070

THE BLUE SQUIRREL END USER LICENSE AGREEMENT REDISTRIBUTION NOT PERMITTED

GRANT.  Subject to pay ment of  applicable license f ees, Blue Squirrel grants y ou a non-exclusiv e license to use the Sof tware and accompany ing documentation

("Documentation") in the manner described below under "Scope of  Grant."

SCOPE OF GRANT

You may :

use the Sof tware on any  single computer;

use the Sof tware on a network, prov ided that each person accessing the Sof tware through the network must hav e a copy  licensed to that person;

use the Sof tware on a second computer so long as only  one copy  is used at a time;

copy  the Sof tware f or archiv al purposes, prov ided any  copy  must contain all of  the original Sof tware's proprietary  notices; or

if  y ou hav e purchased licenses f or a 10 Pack or a 50 Pack, make up to 10 or 50 copies, respectiv ely , of  the Sof tware (but not the documentation), prov ided any  copy

must contain all of  the original Sof tware's proprietary  notices.  The number of  copies is the total number of  copies that may  be made f or all platf orms.  Additional copies of

http://www.bluesquirrel.com/support/
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Documentation may  be purchased.

You may  not:

permit other indiv iduals to use the Sof tware except under the terms listed abov e;

permit concurrent use of  the Sof tware;

modif y , translate, rev erse engineer, decompile, disassemble (except to the extent applicable laws specif ically  prohibit such  restriction), or create deriv ativ e works based

on the Sof tware;

copy  the Sof tware other than as specif ied abov e;

rent, lease, grant a security  interest in, or otherwise transf er rights to the Sof tware; or

remov e any  proprietary  notices or labels on the Sof tware.

LIMITED WARRANTY.

Blue Squirrel warrants that f or a period of  ninety  (90) day s f rom the date of  acquisition, the Sof tware, if  operated as directed, will substantially  achiev e the  f unctionality

described in the Documentation. Blue Squirrel does not warrant, howev er, that y our use of  the Sof tware will be uninterrupted or that the operation of  the Sof tware will be error-f ree

or secure.  In addition, y ou must determine that the Sof tware suf f iciently  meets y our requirements.  Blue Squirrel also warrants that the media containing the Sof tware, if

prov ided by  Blue Squirrel, is f ree f rom def ects in material and workmanship and will so remain f or ninety  (90) day s f rom the date y ou acquired the Sof tware.  Blue Squirrel's sole

liability  f or any  breach of  this warranty  shall be, in Blue Squirrel's sole discretion; (i) to replace y our def ectiv e media; or (ii) to adv ise y ou how to achiev e substantially  the same

f unctionality  with the Sof tware as described in the Documentation through a procedure dif f erent f rom that set f orth in the Documentation; or (iii) if  the abov e remedies are

impracticable, to ref und the license f ee paid f or the Sof tware. Repaired, corrected, or replaced Sof tware and Documentation shall be cov ered by  this limited warranty  f or the

period remaining under the warranty  that cov ered the original Sof tware, or if  longer, f or thirty  (30) day s af ter the date (a) of  shipment to y ou of  the repaired or replaced Sof tware,

or (b) Blue Squirrel adv ised y ou how to operate the Sof tware so as to achiev e the f unctionality  described in the Documentation.  Only  if  y ou inf orm Blue Squirrel of  y our problem

with the Sof tware during the applicable warranty  period and prov ide ev idence of  the date y ou purchased a license to the Sof tware will Blue Squirrel be obligated to honor this

warranty .  Blue Squirrel will use reasonable commercial ef f orts to repair, replace, adv ise or, ref und pursuant to the f oregoing warranty  within 30 day s of  being so notif ied.  IF THE

SOFTWARE IS INCLUDED AS PART OF A LARGER BUNDLE, SOME OF THESE REMEDIES MAY NOT BE AVAILABLE TO YOU.

THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY BLUE SQUIRREL.  BLUE SQUIRREL MAKES NO OTHER EXPRESS WARRANTY AND NO

WARRANTY OF NONINFRINGEMENT OF THIRD PARTIES' RIGHTS.  THE DURATION OF IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION, WARRANTIES OF

MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED TO THE ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT

ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU.  NO BLUE SQUIRREL DEALER, AGENT, OR

EMPLOYEE IS AUTHORIZED TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY.  If  any  modif ications are made to the Sof tware by  y ou

during the warranty  period; if  the media is subjected to accident, abuse, or improper use; or if  y ou v iolate the terms of  this Agreement, then this warranty  shall immediately  be

terminated.  This warranty  shall not apply  if  the Sof tware is used on or in conjunction with hardware or sof tware  other than the unmodif ied v ersion of  hardware and sof tware with

which the sof tware was designed to be used as described in the Documentation.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION.

TITLE.  Title, ownership rights, and intellectual property  rights in the Sof tware shall remain in Blue Squirrel and/or its suppliers.  The Sof tware is protected by  the copy right laws

and treaties.  Title and related rights in the content accessed through the Sof tware is the property  of  the applicable content owner and may  be protected by  applicable law.  This

License giv es y ou no rights to such content.

TERMINATION.  The license will terminate automatically  if  y ou f ail to comply  with the limitations described herein.  On termination, y ou must destroy  all copies of  the Sof tware

and Documentation.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, TORT, CONTRACT, OR OTHERWISE SHALL BLUE SQUIRREL OR ITS

SUPPLIERS OR RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY

CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND

ALL OTHER COMMERCIAL DAMAGES OR LOSSES.  IN NO EVENT WILL BLUE SQUIRREL BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE AMOUNT BLUE SQUIRREL

RECEIVED FROM YOU FOR A LICENSE TO THE SOFTWARE, EVEN IF BLUE SQUIRREL SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR

FOR ANY CLAIM BY ANY OTHER PARTY.  THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO THE EXTENT

APPLICABLE LAW PROHIBITS SUCH LIMITATION.  FURTHERMORE, SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR

CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

MISCELLANEOUS.  If  the copy  of  the Sof tware y ou receiv ed was accompanied by  a printed or other f orm of  "hard copy " End User License Agreement whose terms v ary  f rom

this Agreement, then the hard copy  End User License Agreement gov erns y our use of  the Sof tware.  This Agreement represents the complete agreement concerning this license

and may  be amended only  by  a writing executed by  both parties.  THE ACCEPTANCE OF ANY PURCHASE ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL

ON YOUR ASSENT TO THE TERMS SET FORTH HEREIN, AND NOT THOSE IN YOUR PURCHASE ORDER.  If  any  prov ision of  this Agreement is held to be unenf orceable,

such prov ision shall be ref ormed only  to the extent necessary  to make it enf orceable.  This Agreement shall be gov erned by  Texas law (except f or conf lict of  law prov isions). 

The application of  the United Nations Conv ention of  Contracts f or the International Sale of  Goods is expressly  excluded.

U.S. GOVERNMENT RESTRICTED RIGHTS.  Use, duplication or disclosure by  the Gov ernment is subject to restrictions set f orth in subparagraphs (a) through (d) of  the

Commercial Computer-Restricted Rights clause at FAR 52.227-19 when applicable, or in subparagraph (c)(1)(ii) of  the Rights in Technical Data and Computer Sof tware clause at

DFARS 252.227-7013, or at 252.211-7015, and in similar clauses in the NASA FAR Supplement.  Contractor/manuf acturer is Blue Squirrel, 686 E. 8400 South Sandy , UT 84070.



ClickBook Help File54

© 2010 Blue Squirrel

Index
- A -
About     10

Add a Printer     6

Assemble A Booklet     18

Automatic PDF file naming     37

Automatic Printing of PDF files     37

AutoName     37

AutoOverwrite     37

- B -
Banner     15

Banner (Creating)     20

Banner (Printing)     20

Binding     47, 48

Borders     30

- C -
Carbonless copy printing     38

Categories     13

ClickBook Printer Setup     5

ClickBook's Main Screen     10

Customer Service     52

Cutting     19

Cutting And Assembling A Booklet     18

- D -
Delete A Page     32

Double sided printer     9

Drag And Drop Files To Clickbook     31

Duplex Printer     9

- E -
Email     10

End User Agreement     52

- F -
Files ClickBook Will Print     11

Footer     27

Format A Document     4

- H -
Hand fed tray printing     8, 47

Header     26

Help     10

How Do I install ClickBook     5

How Does ClickBook Work?     2

- I -
Install ClickBook     5

Instant Print     31

Instant Printing     22

- L -
Layout (Selecting)     40

Layout Description     13

Layouts     13

Layouts (Modifying)     42

Layouts (Types of)     39

License Agreement     52

- M -
Margins     47

Mini-Pages     47

Mini-Pages (Adjusting)     34

Modify Layout     16

Multiple Copies     43

- O -
One-Click Printing To Clickbook     31

Open     10

Optimize PDF for the web     37

Options     10

Overlap     16, 19



Index 55

© 2010 Blue Squirrel

- P -
Page Numbering     30

Paper Orientation     16

Paper-Saving Meter     13

PDF     10

PDF Booklet Printing     22

PDF Creation     21

PDF Email     21

PDF Options     37

Poster     15, 19

Poster Wizard     15

Prepare A Document     4

Preview     43

Print A Range Of Sheets     46

Print Jobs     11

Print Preview     13

Print Specific Pages Of A Booklet     46

Print To Clickbook With No User Intervention     31

Print Your First Booklet     3

Printer Properties     9

Printer Quick Click     22

Printer Setup     5, 6

Printer Setup (Custom)     8

Printing A Multi-document Booklet     14

Printing With ClickBook     3

Properties     9

- R -
Reinserting The Printout To Print The Second Side    
44

Repeat     48

Return To ClickBook After Printing     44

- S -
Sample Documents     14

Save     10

Save A Booklet As A ClickBook File     4

Save ClickBook To My Computer     5

Save PDF     37

Scaling Options     47

Setup A Printer     5

Sheet Selection     13

Signatures     48

Status Bar     13

Stick The 2nd Side Of Pages Back Into The Printer    
44

Sub-booklets     48

Support     52

- T -
Table Of Contents (Printing)     32

Technical Support     52

Templates     10

Temporary Settings     10

Toolbar Options     10

- U -
Uninstall ClickBook     9

User Rights     52

- V -
View PDF     37

VIP Key     5

Visit Us     10

- W -
Watermark     28

What does ClickBook do?     1

What's New In ClickBook MMX?     2


	Getting Started
	What Does ClickBook Do?
	How Does ClickBook Work?
	What's New In ClickBook MMX?
	Printing With ClickBook
	Printing Your First Booklet
	Preparing A Document In Its Application Program
	Saving A Booklet As a File

	Installation
	Run The Setup Program
	Automatic Printer Setup
	Printer Setup
	Custom Printer Setup
	Setting Up A Duplexing Printer For Use With ClickBook
	Uninstalling ClickBook

	Tour ClickBook
	ClickBook's Main Screen
	Toolbar
	Print Jobs
	Print Preview
	Status Bar

	Printing with ClickBook
	Sample Documents
	Printing A Multi-document Booklet
	Poster Wizard
	Modify Layout
	Assemble a Booklet
	Cutting And Assembling a Booklet
	Assembling a Poster
	Creating a Banner
	Making a PDF file
	Printing a PDF booklet
	Quick Click Printers

	Advanced Options
	Forms and Letterhead
	Insert A Header
	Insert A Footer
	Insert A Watermark
	Add Page Numbers
	Add A Border
	Drag And Drop
	Instant Print
	Delete A Page
	Print A Table Of Contents
	Print without Images
	Reverse Printing
	Adjustable Mini-pages
	PDF Settings
	Carbonless Printing

	Layouts
	Types Of Layouts
	Selecting A Layout
	Modifying A Layout

	Printing And Printers
	Printing Multiple Copies Sequentially
	Previewing The Printout
	Reinserting The Print Out Stack Before Printing The Second Side
	Return To ClickBook After Printing
	Print A Range Of Sheets
	Hand Fed Tray Printing

	Helpful Hints
	Setting Margins And Binding Space
	Printing Sub-booklets To Bind Together
	Printing On Legal Size Paper
	Repeat

	Glossary
	Support
	License

